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Design Entry Functional Simulation

- Schematic capture - Verify correct logic functionality
- Language-based entry - Estimated timing or no timing
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Timing Simulation
L J - Post-placementiiming info

Design Implementation

- Design translationisynthesis Static Timing Analysis
- Design rule checking - Post-placementtiming info

- Logic partitioningffitting - Faster fresults than timing
- Block placement simulation

- Routing
- Create prograrming file

In-System Debugging

- For reprogrammable parts
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v- Programmable logic devices

\- System-on-a-programmable-chip
v- High-Density

v- High-Volume

t- Mid-Density
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September 1983

T I = Revised January 2005
BSEMICONDUCTOR™

MM74HCO00
Quad 2-Input NAND Gate

General Description Features
The MM74HC00 NAND gates ulilize advanced silicon-gate B Typical propagation delay: 8 ns
CMOS technology o achieve operating speeds{simllar 0 @ Wide power supply range: 2-6V
LS-TTL gates with the low power consumption of standard . — O QSR

- L u srent: 20 pA maximum (74HC Series
CMOS integrated drcuits. All gates have buffered outputs. " owq esconticunont 2 M ! )
All devices have high noise immunity and the ability to B Low input current. 1 yA maximum
drive 10 LS-TTL loads. The 74HC logic family s functon- B Fanout of 10 LS-TTL loads
ally as well as pin-oul compatible with the standard 74LS
logic family. All inputs are protected from damage due to
static discharge by intemal diode clamps lo Vee and
ground.

Ordering Code:

Package Package Description
Number

MM74HCOOM M14A
MM74HCOOMX_NL M14A
MM74HC00SJ M14D
MM74HCOOMTC MTC14
MM74HCOOMTCX_NL| MTC14

Order Number

14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-012, 0.150° Namow

Pb-Free 14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-012, 0.150" Narmow
Pb-Free 14-Lead Small Outline Package (SOP), EIAJ TYPE II, 5.3mm Wide

14-Lead Thin Shrink Small Outline Package (TSSOP), JEDEC MO-153, 4.4mm Wide
Pb-Free 14-Lead Thin Shrink Small Outline Package (TSSOP), JEDEC MO-153, 4.4mm
Wide

14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300" Wide

Pb-Free 14-Lead Plaslic Dual-in-Line Package (PDIP), JEDEC MS-001, 0.300" Wide

Devicas also avsiadia in Tape and Ree! Specty by appanding the sutfix letter "X 1o the ordenng code.
Pb-Froe packago per JEDEC J-STD-0208.

MM74HCOON N14A
MM74HCOON_NL N14A

Connection Dlagram Legic Dlagram

Pin Assignments for DIP, SOIC, SOP and TSSOP

c B4 A4 Y4 83
w o o | |
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* Package Options Include Plastic ‘*Small SN54107, SNS4LS107A . . . J PACKAGE
Outline’” Packages, Ceramic Chip Carrlers, SN74107 . .. N PACKAGE
and Plastic and Ceramic DIPs SN74LS107A . .. D OR N PACKAGE

(TOP VIEW)
* Dependable Texas Instruments Quaiity and

Reliability

description

The 107 contain two indapendent J-K flip-fiopa with
individual J-K, clock, and direct clear inputs. The ‘107
is a positive pulse-triggered flip-flop. The J-K input data
is loaded into the master while the clock: is high and
transferred to the slave and the outputs on ths high-to-
G . . SM54LS107A . . . FK PACKAGE
low clock transistion. For thess devices the J and K inputs
; e (TOP VIEW)
must be stable while the clock is high.

The 1.S107A contain two independent negative-edge-
triggered flip-flops. The J and K inputs must be stable
prior to the high-to-low clock transition for praedictabls
operation. Whan the clsar is low; it overrides the clack
and data inputs forcing the Q output low and the Q
output high.

The SN54107 and the SN54LS107A are characterized

for operation over the full military temperature range of
g0

—95°C 10 125°C. The SN74107 and the SN74LS107A
5 o~ 100 Q D X
are characterized for operation from 0°C to 70°C. NZ 2N

(&)
© o~

9 10 111213
S e § e § e ¥ e U4

NC - No Internad connsction

107
FUNCTION TABLE

INPUTS _L QUTPUTS

CLR CLK

K
X
L
L

H
H
H H H

J
& X
H L
H
L

H

‘L§S107A
FUNCTIONIABLE

INPUTS ouwuvsj
CLR CLK J Q a_
L
H

X L H

L 0o Qg
H H Lo
£y L H
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description

The "48A, ‘47A, and ‘LS47 feature active-low outputs designed for driving common-anode LEDs or incandescent
indicators directly. The ‘48, ‘LS48, and 'LS49 featura activa-high outputs for driving lamp buffers or common-cathode
LEDs. All of the circuits except 'LS49 have full ripple-blanking Input/output controls and a lamp test input. The ‘LS48
circuit incorporates a direct blanking Input. Segment Identification and resultant displays are shown below. Display
patterns for BCD input counts above 9 are unique symbols to authenticate input conditions.

The ‘48A, ‘47A, '48, 'LS47, and 'LS48 circuits incorporate automatic leading and/or trailing-edge zero-blanking control
(RBI and RBO). Lamp test (LT) of these types may be performed at any time when the Bl/RBfg node is at a high level.

All types (including the ‘48 and 'LS49) contain an overriding blanking input {BI), which can be used to control the

lamp Intensity by pulsing or to inhiblit the outputs. Inputs and outputs are entirely compatible for use with TTL logic
outputs.

The SN54246/SN74248 and ‘247 and the SN54LS247/SN74LS247 and 'LS248 compose the & and the T with
tails and were designed to offer the designer a choice between two indicator fonts.

L=

7 8 10 1 12 13
NUMERICAL DESIGNATIONS AND RESULTANT DISPLAYS

= [ | T
1_:_] H_J H—_ 1
2 6

3 4 5

1

SEGMENT
IDENTIFICATION

‘46A. ‘47A, 1.S47 FUNCTION TABLE (T1)

DECIMAL

— OUTPUTS
OR BiI/RBO?
FUNCTION ET

|

ps)
m

a b c d °
ON | ON | ON | ON | ON
ON | ON OFF
ON [ ON ON | ON ON
ON | ON | ON | ON | OFF ON
OFF | ON | ON | OFF | OFF | ON | ON
ON |OFF | ON | ON | OFF | ON
OFF |OFF | ON | ON | ON | ON | ON
CN | ON | ON | OFF | OFF |CFF
ON | ON |ON | ON | ON | ON | ON
ON [ ON [ ON [OFF [ OFF | ON | ON
OFF | OFF {OFF | ON | ON |OFF | ON
OFF |OFF | ON | ON | OFF | OFF | ON
OFF | ON |OFF | OFF | OFF | ON | ON
ON |OFF |QFF | ON | OFF | ON | ON
OFF | OFF |OFF | ON | ON [ ON | ON
OFF | OFF |OFF | OFF | OFF | OFF | OFF
OFF | OFF |OFF [ OFF | OFF [OFF | OFF 2
GFF | OFF |OFF | OFF | UF¢ juri | urr 3
X l lowlowlowlorvlom[ma!o.w 4 l

X

o ol ol s e Y il Bl B -

Tl o e e el

b o s 2

12
13
14
15
B! p,

RBI L
I I
H = high lavel, L = low levae!, X = irrelevant
NOTES 1.

XXXXX)(XXXXXXX!XXX

X rrjlxrxxzjecre r

The blanking ‘input (Bi) must bs opan or held at a high logic level whan cutput tunctions O through 15 are cesired. The
rippla-blanking input (HBI) must ba opan or high if blanking of » decimal zaro is not desired.

Whan a low logic lsval is applisd directly to the blanking input (81), an sagment outputs are off regardless of tho level of any
othar Input,

2z

3. Whan ripple-blanking input (RB1) snd Inputs A, B, C, and D aro at a fow laval with tha lamp test input high, all segmant putpuls

go off and tha ripple-blanking output (HBO) goas to a low levul (response condition).

Whan the blanking [nput/ripple blanking output (B1/ABO) is opan or held high and a low is spplied to the lamp-test Input, al!
sagmant outputs are on,

4.

1B1/RBO Ia wire AND logic sarving as blanking input {BI) and/or ripple-blanking output (RBO).

Somd G Sioled Olaseine Y-V s
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SN5446A, '4TA, '48, SN54LS4T, 'LS48, 'L S49
SN7446A, '4TA, '48, SNT4LSAT, 'LS48, 'L S49
BCD-TO-SEVEN-SEGMENT DECODERS/DRIVERS

SDLS111 - MARCH 1974 - REVISED MARCH 1988

‘46A, '47A, 'LS47 48, ‘L5848

‘LS49
feature feature

feature
Open-Collector Qutputs Intarnal Pull-Ups Eliminate e Open-Collector Outputs
Drive Indicators Directly Need for External Reslstors

Lamp-Test Provision Lamp-Test Provision

Leading/Tralling Zero
Suppression

e Blanking Input

Leading/Tralling Zero
Suppression

SNB448A, SN5447A, SN54LS47. BNE448, SNB4LS47, SN54L548 . . . FK PACKAGE
SNB4LS48 . .. J PACKAGE

(TOP VIEW)
SN7446A, SN7447A,

SN7448 ... N PACKAGE ’ o0
SN741L547, SN74LS48 ... D OR N PACKAGE OmzZ > -

(TOP VIEW] 3 2 12019

LT 8 g
BI/RBO 17(] a
NC 18 NC
RBI ‘Stlb
Dijs 4] c
9 10111213

1
2
3
4
|5
1s
7
8

<NV D
Z 2
(G}

SN54LS49 ...J OR W PACKAGE
SN74L549...D OR N PACKAGE

(TOP VIEW)

SNG4L549 . . . FK PACKAGE
(TOP VIEW)

NC — No Internal connaction

s cin Sl aBCD Jus sl )0 Slaseis F-¥ s
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module full_adder (S, C, A, B, Cin);

output S, C;

input A, B, Cin;

assign S= A~B " Cin;

assignC=(A & B) | (A &Cin) | (B & Cin);
endmodule
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module full_adder (S, C, A, B, Cin);
output S, C;

input A, B, Cin;

assign {C, S} = A+ B + Cin;
endmodule
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module two_bit_adder (S, A, B);

output [2:0] S;

input [1:0] A, B;

wire C_b;

full_adder 10 ( S[0], C_b, A[0], B[0], 1’0 );
full_adder 11 ( S[1], S[2], A[1], B[1], C_b);
endmodule
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module d_flip_flop (Q, D, clk);
output Q;
input D;
input clk;
reg Q;
always @(posedge clk)
Q<=D;
70
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module d_flip_flop (Q, D, clk);
output Q;

input D;

input clk;

reg Q;

always @(negedge clk)
Q<=-~D;

ebdmodule
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module d_flip_flop (Q, D, clk);
output Q;

input D;

input clk;

reg Q;

always @(posedge clk)

if (reset)

Q<=0;

else

Q<=D;

ebldmodule
obey y2 g all ailas 29,5 50,5 yao gl cels oaig Vb ad 4 g3l aSul oy il QB)S‘*"T reset oyl pedlesn 0uS 5,8 Yl

(Wlogn 0332 45 plailon ey 4) 1958 g0 90 (2l 42 aaliyy ool Sgh iS Jao | (g3 o Sy oo
always @ (posedge clk or posedge reset)
if (reset)
Q<=0;
else
Q<=DO;
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module four_bit_mux (mux_out, mux_in, mux_control, clk);
output mux_out;
input [3:0] mux_in;
input [1:0] mux_control;
input clk;
reg mux_out;
wire mux_out_w;
assign mux_out w = (mux_control == 2’b00) ? mux_in[0] :
(mux_control ==2’b01) ? mux in[1] :
(mux_control ==2’b10) ? mux_in[2] :
mux_in[3];
always @(posedge clk)
mux_out <= mux_out_w;

endmodule
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module four_bit_mux (mux_out, mux_in, mux_control, clk);
output mux_out;

input [3:0] mux_in;

input [1:0] mux_control;

input clk;

reg mux_out;

always @(posedge clk)

case ( mux_control )
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2’b00 : mux_out <= mux_in[0];
2’b01 : mux_out <= mux_in[1];
2’b10 : mux_out <= mux_in[2];
2’b11 : mux_out <= mux_in[3];
default : mux_out <= mux_out;
endcase

endmodule

$99,5 mMux_control ;1 Jlase o gly g 9S50 S |, MUX_cONtrol (04,9 Cunsg onig YU 4t ;o j0 «€ase jgws jleslatwl L YL asb 5
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module ram_interface (address_out, data, rnw, reset, clk);

output [15:0] address_out;
inout [15:0] data;

output rnw;

input reset, clk;

reg [15:0] address_out;

reg rnw;

reg [15:0] access_address;
reg read_write_turn;

reg [15:0] data_in_register;
assign data= (! rnw ) ? 0 : 16’bz;
always @(posedge clk)

if (reset) begin
address_out <= 0;

rnw <=1,
end
else begin

if (rnw ) begin

data_in_register <= data;
access_address <= access_address + 1;
end

if (data_in_register == 16 hff0f)

rmnw <= ~ rw;

if (1 rnw)

rmnw <= ~ rw;

end

endmodule
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module d_flipflop_2clks(clk1, clk2, d, q);
input clkl, clk2, d;

output g;

reg q;

always @(posedge clkl or posedge clk2)
begin

q<=d;

end

endmodule
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1

Synthesis

1

Functional Simulation

Design correct?

Tes

No

|

Fitting
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Timmng Analysis and Simulation

File Edit Wiew Project Assignments Processing Tools Window Help

Timing requirements met?

Programming and Configuration
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Quartus Il ,l38ls 5 b 21,k

DEE (S| & 2@ |0 0]
FEE AL A

|

ol 53l 5 ol 5l eslicial b b ol

Qg ol laze 5)ls U aslei 211

Project Navigator =l =l
Entity |
Compilation Hiemrchy|
] Hlerarchy IT% Files I o Design Unitz I
Status 2l
Module: | Progress 72 [Time & |
@ Documentation
x|
i

o =
g Syslem){ Processing )\ Extra Info )\ Info )\ Warning )\ Critical */arning )\ Errar )\ Suppressed /
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o, b oS ol 1) File>New Project Wizard sk (! gl 8,5 oo &S50 Wizard S Lawgs 15818 5 ol 10 35z 055 5 S ol

D9 obled

e =

The Mew Project “Wizard helps you cieate a new praject and preliminary project settings, including the

faollowing:

- Project name and directony

* Mame of the top-level design entity
* Project files and libraries

- Target device family and device
* EDA tool settings

*rou can change the settings for an existing project and specify additional project-wide settings with
the Settings command [&ssignments menu). 'r'ou can use the various pages of the Settings dialog box
to add functionaliy ta the project.

[~ Dont show me this introduction again

< Back Mesdt > Firigh Cancel

YoV S

Sed Hbled oz b oS SIS, Next asy 35

New Project Wizard: Directory, Name, Top-Level Entity [page 1 of ﬂL [

What iz the working directary for this project?

IC:\a\tera\quartusBD |

What iz the name of this praject?

[Fulladdef =]

What iz the name of the tap-level design entity far this project? This name iz case sensitive and must
exactly match the entity name in the design file.

[Fullectder _|

Use Existing Praject Settings ...

< Back Nexd > Finish Cancel

-V S

(3550 5,5 ;i )5 (L, Top Level Jsslo el 5 03, oL Ygane) ;o 5L )5 593 0392 4 bga o Sledbl 0,53 (5l 5 ot 5 1

\a




New Project Wizard: Add Files [page 2 of 5] [

Select the design files you want to include in the project. Click Add Al to add all design files in the
project directory to the project. Mote: you can alwaps add design files to the project later.

File name: I[ _I Add... |
File name | Tupe | Add Al |

Remove

Froperties

Up

g

Drown

Specify the path names of any non-default libraries. User Libraries. .. |

< Back Nedt Finish

Cancel

BV S

QS 28 Do cpl puf 50 wrd o plol gxlia ]y Jes cpl e ol o WiZArd ol aisls 0g2g 055 4y (0,5 adlal ¢l LB 31
O 69y b zyb el J1,3 a5 glasl 5 gg5 00,5 jall s o,z b od,S SIS 1) NeXt. oo ,lai 055, a0 (40,5 a8lol 51y 09250 LB

(Device:Emp7128SLC84-15 4 Family:Max7000s).0.:5" US|, NexXt s 5 ol cad 51 511 09 ool

Mew Project Wizard: Family 8 Device Settings [page 3 of Ei- E

Select the family and device you want to target for compilation.

r Show in ‘Available device! list

Famiy:  |M&x70005 =l
— Target device
" futo device selected by the Fitter
* Specific device selected in ‘Awailable devices' list Speed grade:  |Any hd
Core voltage: 5.0V

¥ Show Advanced Devices

Package: Ay -

Pin caunt: Ay hd

Available devices:

Mame | Macra... | -
EFPM 712851 C84-7 128
EFR71285LC84-10 128

EFM 15

EPM71235L184-10 128 U
EPM7128500C100-6 128
EPM712850C100-7 128
EPM712850C100-10 128
EPM712850C100-15 128 L

Companion device

HardCopy II: I ;l
[V Linit DSP & Fiéshd to HardCopy || device resounces

< Back MNend > Finish Cancel

5V U
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6l b Lol o les Ll oS oolal Third Party mMhaslay slo l38le 5 5l Quatus 11 s ogdle aualg> oo ST Wizard 3l ceond cpl ;o
Sleadas 5l glaoMs e 0SS 1) NeXt s (oS oo oolawl Quartus 11 1o sl Iyl 51 (>lhb a5 > laceand plos

A.A.S «S...IS ‘) F|n|5h 09.....»‘59 J.QUO O).?Lu «S_v )\) 3 0)5)4 (5‘)-’ OM‘QIZ"

New Project Wizard: EDA Tool Settings [page _ [

Specify the other EDA tools - in addition ta the Quartus || software - used with the project.

[ ED& design entry/synthesis tool: I LI

Format: I x l

[~ Mot available

[” EDA simulation tool: I ;I

Fuormat: I j'

[T Mot available

[ EDA timing analysis tool: I LI

Forrmat: I i l

[T Mot available

< Back MNext > Finish Cancel

V-V S

. e —

‘when you click Finizh, the project will be created with the following settings:

Project directary:

C:/aleralquartussls
Project name: Fulladder
Top-level degign entity: Fulladder
Murnber of files added: 0

Mumber of uzer libraries added: 0

Device assignments:

Family name: MAXTFO00S

Device: EFM71265LCE4-15
ED& tools:

Design entry/synthesis: <Mones

Simulation: <Mate:

Timing analysis: <Maoner

<Back | Mewr [ Fmsh | Cancel

A=Y IS
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I T3 Quar - Ci/al o = |

File Edit View Project Assignments Processing Tools Window Help

Dl |&| & 2| o |k |[faad |
32 » BB (T |r wr b &8 a
Project ————————alx|
Entity
MAX7000S: EPM71285...
& fulladder
"Hierarchy E] Filesl &P Design Units
Status. ==l
Module | Progress Z [ Time & |
x|
|

% Suztem )\ Processing )\ Extra Info )\ Infa )\ W arning )\ Critical " arning )\Enol/{ Suppreszed /
4]

z IMessage il il ILocation: LI Locate I

For Help, press F1 [ [ | Idle 2 |

LY s

Verilog Design Entry

<l |, Verilog HDL file . g FileDNew jglais ] (gl pee o Quatus 11 ,l58le 5 il s g daxs a4 5Ls MVerilog oS i sl

09 5k Kinlpg e e B oS OK

Device Design Files | Other Files

AHDL Fila
Block Diagram/Schematic: File
EDIF File

SOPC Builder Sistem

WHOL File

Voo s

\ 24




Awles ol 1) Verilog 4 35 Save Type As o 5 File>Save As LB 0 5 0,53 6l

A4S ol |, Add File To Current Project as 557 5 s g File Name cwnd (o 1) L1 ol

.A....S o)pdjdwju)imlfj.‘a.m&b ‘) 09.’> )JAJQ)BA.ASV[D ..\....S;i..lfb Save

solelVerilog ol giws 5l ol lagSl o et 4 ol coylas 4 S Verilog b ol jgiws Syntax o8 e bl 4 OByl Sy

A8 ool 1) Edit->Insert Template>Verilog HDL LagSUl -l 5l eolawl (gl 0,10 9529 15810 5 59,0

038yt S 4 B Jylb 53,5 AL

Al oo &Sl b g 0uS SIS I File o Caos (gt 5l 058 palls 5 0y b aaS” Gl | Assignment->Setting a8

[
[

- General

- |Izer Libraries [Current Project]
Device

#- Timing Analyzis Settings

H- EDé Tool Settings

|- Compilation Process Settings

H- &nalysis & Synthesis Settings

- Fitter Settings

- Azsembler

- Design Agsistant

- SignalT ap Il Logic Analyzer

- Logic &nalyzer Interface

- SignalProbe Settings

H- Simulatar 5ettings

- PowerFlay Power Analyzer Settings

Select the design files you wart to include in the project. Click Add Al to add all design files in the

praject directany ta the project.

File: name:

=

File: narne

Type

S ol |, Project->Add/Remove Files in Project

Settings - fadd =

Categary:

Add Al

diaids

Cancel

V-V S

b5l plas. 00,5 o, kais 50 a5 (59, s3lwooly BB ¢ i Ul J58le 5 10 09340 calizes (sla,l5l Lawgs oobariss Verilog oS

S5 lals s sl

g oo Sy Ll b dr 69,15 asl SG Al

o5l 59, &Sl b g awsles Ll |, Processing > Start Compilation 435 LLslS sl>! sl p
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Iy Uas 5g>g o doplig pl )l 092 JIGI L Uas 289 ol b 05 oo 00ls lis calizee slapliy 50 Lol laore bl 0, o

Slgs oo U o yiiny bl sl 98 o0 ateie JIAT S 90 aclipy b3 llas pliy 5o (55, Sl kso b wilyioe 5 wuled oo Ol

ol SIS 1 FL 5 ongas ol 1 aliy

@ Compilation Report - Flow Summary |E”E”E|
IZ5-3 Compilation Report Flow Summary
- &HBE Legal Motice
- ¢&HE Flow Summary
3B Flow Settings Flow Status Successful - Sat Apr 18 23:39:44 2015
-8 Flow Non-Default Global S¢ | Quartus Il Version 6.0 Build 178 04/27/2006 SJ Full Version
@% Flow Elapsed Time Revigion Name a
é Flow Log Topdevel Entity Name fulladder
-0 Analysis & Synthesis Farmity MAX7000S
[-&H0 Fitter Device EPM71285LC84-15
- &0 Assembler Timing Models Final
E]--%D Timing Analyzer Met timing requirements ~ Yes
Total macrocells 1/128(<1%)
Total pins 6/63(9%)
4 F

WYY S
onl Al T e 9929 a0 Slogsl & yguods 5,155l saima ylis 0oy g .09 g0 00l 3155 s blaelS Joe plasl jl o crien

g 0 3k 3 & a5l g, SIS L 4 Processin> Compliation Report bl b )58

Quartus I
File Edit View Project Assignments Processing Tools Window Help
DEHE & A2 |a slixree® AR
Project Navigator F- R | € Compitation Report - Flow __. |
Entity |Ma:l =
MAX7000S: EPM71285LC84-15 1 3wt
ebc Fulladder q | module fulladder (5,C,A,B,Cin):
& Compilation Report - Flow y [ B[]
ga Cempilation Report Flow Summary
BB Legal Notice
a 1 | b --¢&HER Flow Summary
~ dyHierarchy [ B Files | 87 Desian Units &HER Flow Settings Flow Status Successful - Sat Apr 18 23:39:44 2015
--¢&hER Flow Non-Default Global Se | Quartus Il Version 6.0 Buid 178 04/27/2006 S Full Version
Status = x| --¢ZHE8 Flow Elapsed Time Revision Name a
Module | Progress 7 [ Time & & B FlowLog Topdevel Entity Name  Fulladder
Full Compilation 00:00:18 -&H0 Analysis & Synthesis Family MAX7000S
Analysis & Syrthesis 0000:02) || - Z(0 Fitter Device EFM712851C84-15
Fitter 00:00:03 &0 Assembler Timing Models Final
Assembler 000010 e él:l Timing Analyzer Met timing requirements ~ Yes
Timing Analyzer 00:00:03 Total macrocels 1/128(<1%)
Total pins 6/68(9%) [
4 m *
& Documentation
4 [ 1 ] » < m | b
Longest tpd from source pin "a" to destination pin "c" is 15.000 ns -
Quartus II Timing Analyz was successful. 0 er ., 1 warning
Quartus II Full Compilation was successful. 0 =2, 1 warning \:\
4| ([} r
wn
“%’. System )\Plucessing Extra Info Infa A “aming Critical W arning Errar Suppressed
a3
g |Msssage Oof 51 F |Locatmn: J
For Help, press F1 L] [ Idle NUM

VoY S
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Sl oolaiuls ge sl LE gy slaws (5155 cpl jo e iloonds Cd 2 Cans Gy j0 aS Al 0 3By iz ol (3,155 ol
Analysis & bl b wigd co adgs i Joe 5l am JhlalS lawgy a5 dlaie OVolas aSOI L 5 cwl oad jasein )b (g5lwosly

D9 g0 o3l lis Synthesis—->Equation

Tob ilwands

Lsd ol ead b jlas gileans ol sleacs )l Quartuss Hogs sl o5lwancs Joe b FPGA gy, 7,b (silwosly 51 L3
bly g by 29,5 pizmen 0980 0ol jlae slo (639,5 4 ool Test Vector ob L slazge S conl o3V (g 5lwand plxl 51 L3

Ot |y 29,5 5920 oo zyb oald (g5lwosly Jow 4y 1) TEXE VECTOr. jludacd (. 53,5 (astive g 0dsd Sl a3V aS J>1s 15405l

olsasl 1) Other File osy g File> New laol jslais oy e les oo oolaiw! Waveform Editor ;l Quartus 11, Text Vector sbx! sl

S SIS, Ok Vector Waveform File el Lass

New

Device Design Files  Other Files

AHDL Include File

Black Symbol File

Chain Diescription File
Hexadecimal [Intel-Format] File
Logic Analyzer Interface File

b emary [nitialization File
SignalT ap [l File

Tl Script File

Text File

*ector Wwaveform File

]S I Cancel

VY S

e 0 3L Waveform Editor Lo 4
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1) WaveformLvw [=lE =]
Master Time Bar:|  19.225ns J_Pl Painter: | 21.6nz Interval: 23 ns Start; End: |
e Value &t ps 1111] ns 21].1] ns |
19.23ns 19-2215 ns
4 kA k
VY-V s

29 3k 30, b oS ool 1) Edit->Insert Node or Bus g (6 jlwdnds Jlow sl (25,5 9 (693)9 pu2le> oo

M arme: I[ oK I
Type: IINF'LIT ;I Cancel |

Y alue type: IS-LBVB| ;I Mode Finder... |
Fiadix: I Binary j

Bus width: I'|

Start index: IE|

[~ Dizplay gray code count as binary count

VAV S

&y 1y List ax g Pind:all sl eoles oolazwINode Finder 1 el yigo bl guosio Name yizo 10 1) o pb puilsd oo o ] jo
Jos o050 ddlol sais bl glo Node a4 b asS SIS > cadle (g9, 5 bl | lais g0 JLiSaw .0sS SIS s Node (0,5 oy
&S o g5 3l MaxPIUs l8ls 5 alie (63959 (slo JUSoms a3 Jl> .0iS SIS OK (5, 0 5 08 1S5 o JUSs 4y sl 1,




MNode Finder

Mamed: | LI Filter: IF'ins: all LI Customize. .. | List I

Loak in; |[EIEEEE] LIJ ¥ Include subentities Stop I Cancel |
Modes Found: Selected Nodes:

MNare | Agzignments I ] | Mame | Azsighments | ]
3 PIN_30 | I [fulladderla PIN_30 |
Lo ! PIN_12 [ I [fulladderlc PIN_12 (

VAoV S

O 5o Ol e 5 dile oo (Blod 93 Helle O jod S5 (25,5 Tae SIS 639y Slagse SO Sl Sl

Sled 03],y b Logd o adrive giluand

1ri Waveformi vwf* =5 i=E ===
tMaster Time Bar 19.225 ne J_PI Painter: | 251 ns Interval: 588 ne Start: Ops End: | 1.0us

ul:] 10.0ns H0ns |
Value at ] 1
Name 19.23 ns 15225 ns
-
- 3 BO |
£ c BX R R

Silwals 5l =

oadaid § 1l o el 15 g 5 Jlossl (ol (slo a5 o LE ool (29,50 39 (53lotend g 99 & Wl n o >k e

s Sy gilwans QT 4 a5 oudbdwlone b ,Lisl ),ol., plod (il oo 0duzmn aS 290 Jhg,,0 dingS oo (60 S (giluad QT 44
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&0y oe (5 5lwdands

Generate 4 bl |, Functional 435 Simulation Mode (!, e Processing->Simulator Tool (sjlwacs cpl slz! sly
o i § IS SAVE.OLBY Jlade (635,5 slo JUKiw 4 g aiS SCUS OpEN (g9, p e S Sl |, Functional Simulation
O 8l aulys oo laz ey g Coddae b plas! 51 g S SIS Start aiy 35 g9, » 5 aS bl | Processing—> Simulator Tool

ST SIS Report a8 (55, 2 (295

|- ;
00,5 oo b p3 oyt g (3,155 (6lwand Cadbge Ll jo g 0gd e TN T eSO 5l eslannl b (g 5lwans

@ Simulation Report - Simulation Waveforms EI-EI @
ga Simulation Report Simulation Waveforms
% Legal Motice Simulation mode: Functional it
- ¢HEH Flow Summary
- ¢SHEB Flow Settings -
=& 3 Simulator
S Summary Master Time 12.0 nz j *| Pointer (13,35 ns Interval| 1.35 ng Start End
@% Settings 0 ps 10.0ns
&8 Simulation Waveforms Name | ‘B T T20ms
&[0 Simulation Coverage - EL
-SHEB INI Usage [ g a BO
-5 E) Messages | | c BEO
1 r r
AT AL

Sl ilwand

9y Silwooly 5lam Jlawe oa8ly L8 o U o oo plxil 1) Sloj (g5luancds coads ol jlaw o Slae 051 Cowyo 5l el 51 oy

OK g w5 oo,k ;0 (o3lwacd oo sl |, Timing as ;5 Assignment->Setting-> Simulator Cbesjloxs oplplo .Cww> FPGA

e Obles 9,5 zae S8 50 SWlSFlitch sla JLSw 5 o35 ¢ (5jloancs 5121 5l ons amlod oo

FPGA 5,91 595 2 Gilwesly

Ubu.u gl.w.’ﬁ

0 S ok 5 Jgile sle (73,5 9 (699,59 sl dwlgZu aSTT, FPGA 5l oo s Quartus 1w pdy &5 (358 O j50a JilalS 51
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@ Assignment Editor EI@
13 5 category: [l j| T A o Pin| o) Tlming| # Logic Opﬁons|
! + Information: | The Assignment Editor is the interface for creating, editing, and viewing individual assignments, induding pin assignments, in the Quartus II software. To cre
(=] F Edit: ¥ [ |
From To Assignment Mame Value Enabled
i | B B Location PIN_30 Yes
2 o Location PIN_12 Yes
e 3 £ MR = LENEW > > LENEW >
&=
o
q°
o
b
k4
'

VY-V S

I, Pin oalsasl )l cancd o g sl 1) Assignment DPins jglaie oy 058 o colaiwlAssignment Editor 150 51 by olucsl 6l
4 (295 b 69959 10 59y d9ber b 50mb oy S S ST Ly ik Ky oS ] SSNEWS> a5 00908 SIS

03,5 o3l 6,5 0y O SIS )9 b s 025 4118 Jpazr 53 U oS SIS sl o

Location |I,|O Bank 10 Stardard |General Functicn Specid Fun|
[OER | LVTTL
FIN_[¥24 10 Bank 5 Row 1|0 LiDs125p ~
PIN_M25 /0 Bank S Row I|C L/D5125n0
PIM_M1 I'D Benk. 2 Dedicated Clock LK1, WDSCLKOn, Inpuk
PIN_MZ I/ Bank 2 Dedicstad Clack, L0, LYDSCLEDE, Input
PIN_N9 /O Bank 2 Raw I|C L/DS3lp
PIN_M18 1O Bank § Raw 1|G /DS 10p
PIN_M20 10 Bank 5 Row I|0 L/DS124p
PIN_MZ3 I Bank S Row I0 Ly0s126p, DRCLKZ/DOS0R/COLR
PIN_M24 IO Bank & Row I|C L/DE126n
PIN_N25 110 Bank § Dedicated Clack LK, LVDSCLKZE, Input
| I'C Bank. 5 Dedicsted Clock CLKS, VDSCLKEr, Input
PIN_P1 1D Benk. 1 Dediceted Clock AK3, IVDSCLELR, Input
PIN_PZ I'0 Bank 1 Dedicsted Clock AkK2, IVDSCLELE, Input
FIN_P3 10 ek 1 Row I|o LYDS526p, DPCLK JDQSILICQ1L#
FIN_P4 /0 Bank 1 Raow I|C L/DS26n
PIN_PE 1/ Berk 1 Row 1|0 LDs2zn
PIN_P7 1D Benk. 1 Row IO LiDs22p
PIN_PO IOBnkZ  RowIO LYDS3n
PIN_F17 IO Benk. 6 Row 1|0 LYDS5130n
PIN_F18 1/0 Bank S Raw I|C LyDE110n hd
VYOV S

5 ol clo o a5 1y 093 b 100 b anled 0,033 |, by (arass Ll ol FiledSave 5l oslil b (y5:STaues amass FPGA

Saled flaols conl ouloais 57 1a5 1o o 29,5 5 (699,9 sl 1) L Ha3s 590
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FPGA ‘5}40)4.00).3

&l p SNl g5l aS 09y (5l BB S g 058 oo adgQuartus 11 )53l 5 Assembler lawgs o ls zlisl (65,40l sl a5 LG
@iz a5 POF Wguw L LB 5l Lo Lxs] jo.ccsl SRAM Object File aasce a5 aib o .SOF L cpl .ol o FPGA (a8

2 bl [y FPGA (633,46l 5 JTAG Lawly 35,k 5l g (55lae (g0i,500 SO L aS wws o 1) o5l>] opl a5 il Program Object File

Seb ol 50, b awles ol | Tools—>Programmer .aiss oo ,L FPGA

2 Harwors Senup...| | L SEBlazer [LISD.0) Mode: | IT26 | Froges: oz
W Fi= Devee Checszum Upecode E&?::; =il Eﬁa Exarne
ligh.cet EFZLIFESZ OEFIEE  FFFREFFF 0 O 0O 0
o Auto Dalect
G s Fie,
£ ]
Y-V S

Hardware cood 5l g 0y .50 i 10 0w 5l |, ITAG.0LS asei |y ol dlgs oolawl a7 s0w 5 (6,18l 10,595 ol p3Y Lxsl o
A5 5 ,5:0,0 Lo 098 olwlid pacw 4 Jaio FPGA b ouS” SIS |, Auto Detect a5 .ouS Sl 1) ByteBlaster 4, 55 Setup
S y4eb p FPGA b 0uS SIS Start (gg, p (w9 0S50 1, LB Add file ay 35 51 eolaiwl L a5 1,8 cad jo bads (g3 40b 0 L1
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New Project Wizard: EDA Tool Settings [page 4 of 5]
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New Source Information

Project Mavigator will create a new skeleton source with the
following specifications:

Source Type: Wernlog Module
Source Mame: Fa.v

Module Mame: Fb
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Source Directory: c:\Fa
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Additional new sources can be added after project creation using the "FProject-»New Source”'
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Ewisting zources can be added on the next page.
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Souices in Projest \ £ /) Module Hawe:  Fh A
8 // Project Name:
B Fae 10 // Target Device:
= €1 #3560 5p0208 11 // Tool versions:
EEY) 12 // Description:
1347
14 // Dependencies:
15 4/
i8 // Revision:
17 // Revision D.01 - File Created
i8 // Additional Comments:
L -
8 Moduls Visw | 108 Snapshot | I0) Library Viw 20 FPPEEIIEEERIEIITIE LRSI BRI EEELEEI IR IR
21  module FA(L, B, cin, 5, Cout):
=k 22 input A;
Processes for Source: "F&" ‘ 23 input B:
B  AddExisting Source 24 input ein;
(] Create New Source 25 output S
E  View Design Summany =25 output Cout;
+-f  Design Utiities &
“ @  User Constaints 28 [} assign {Cout,S)=A+E+cing
+ X 30 Sunthesize - K5T e
+ %% Implement Design 20 endmodule
+ 3 Generale Programming File 31 =
< »
1= 4 1
SePocssVien| Faw Design Sum
ﬂ A~
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B Faise
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Fis [P

Add Source, . nsert
Aadd Copy of Source... Shift+Insert
Remave Delets
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N B Module Viey
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New Source

BrM File

@ Implementation Constraints File

Q‘ IF [Corelaen & Architecture 'Wizard)
MEM File

File: Marne:

)

>

[8] Schematic |TB—F'£‘
EI State Diagram

Location:

@ Uzer Document
Werilog Maodule
Yerlog Test Fisture
Iy wHDL Library

[ ¥HDL Madule

[#] vHDL Package
[ wHDL Test Bench

o)

|c::\FA

s Caticel |

Help |

VoY S

Source File

< Back Mext > Cancel Help
YA-) - S
New Source Information E|
Froject Mavigator will create a new skeleton zource with the
following specifications:
Source Type: Test Bench “Wavefarm
Source Mame: TE_FaA thw
Azzociation: FA
Source Directony:  c\FA
< Back Firis Cancel Help
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Check = Assign

Clock Information

" Single Clack

" Mulkiple Clocks

i+ i

~ * Combinatarial {ar internal clock)
Combinatorial Timing Information
Inputs are assigned, outputs are decoded then
checked, & delay between inputs and outputs avoids
assignment checking conflicks.

Check Cutpuks | 20 ns After Inputs are Assigned

Assign Inputs | 50 ns After Outputs are Checked

Global Signals
™ PRLD (CPLDY [~ SR (FPGA) Initial Length of Test Bench; | 1000 ns

Time Scale:
High for Initial: ’7 s ime Scale: [ g -

[™ Add Asynchronous Signal Support
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ile Edit Wiew Project Source Process  Simulation  TestBench Window Help

BE

D[=fa |2 || F@|E] ]=E|m £ 2| sl@f [

Sources in Project ] |1 & i
B Faise .
=1 #e%505pq208 End Time:
= FALEA 1000 ns s0ns 150ns 250ns 350ns 450ns £80ns BS0ns 750ns 880ns 950ns
(2] TE_FA (TELFA thw) P v b b b b b bt da
ana 1 1 E
ne 1
ANcin 1
Mms 0
= M cout 0
B ModuleView | B Snapshat ... |E Libramy View
= |
E 1
“ K K v
" B Frocess View | BB Hisrarchy - TE_FA thiv Fav | X DesianSum. BB TB_FAtow
= Haximum output required time after clock: No path found ~
Haximum combinational path delay: 7.82u4ns
Compiling verilog file “c:\fa\Fa.u" v

B Conzole I a Find in Files | 3€ Emars | ¥ warnings

Sawes the active file

g e 1 45 435 Proccess View s <o o b o tow o ’ o g3 ludnnd az onal
55 Cond o @ bgy e slaasys P VieW 5 <5 50 b oS S5 W sigeuy b L6 (55, 1S Il (3l azs osaline (o1,

1) JSs
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A amino b oS LS L g0 pge a3 L o Generate Expected Simulation Result <35 g5, ,» Xilinx ISE Simulator acgeze 5 51 onw

ilinx - Project Navigator - c:\FAVFA.ise - [TB_FA.tbw]
Bl Fils Edic Wiew Project Source Process Simulation TestBench Window Help
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S0ns  1680ns 3250ns 350ns 450ns 550ns 6G50ns 750ns B850ns 850ns

2l
Sources in Project: | : I:| I‘\ ’I
B Faise Lo
€3 %30 5pq208 End Time:
SR FA R 1000 ns
TB_FA [TB_F lbw) .
ana
ane
flcin
s
= Cout
B2 Wodule View | 0 Snapshot | L) Library View n

2lx
Processes for Souwrce: "TB_FA" |
Bl Add Existing Souice
B Create New Source
B ’ Yiew Generated T est Bench &s HDL
[ AddTest Bench To Project
=@ il 1SE Simulator

Generate

Simulate Behavioral Model
BB Simulate Post-Place & Routs Modsl

< [ » JEN JR—

[ NN B I .
Fasw = Design Sum. = TB_FA thw

] B Process View = Hierarchy - TB_Fé.thuw

ﬂ Simulator is doing circuit initialization process.

~
Finished circuit initialization process.
Success?! Annotation Simulation Complete.
Stopped at time : 1.080 us : File “c:/FA/TB_FA.ant" Line 57
Compiling verilog file “c:\fa\FA.u™ v
" [l Console [G Findin Files | 3€ Enore | § Warmings
A
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EMM File
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@ State Diagram
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EI zer Daocument =y
Werilog Module
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Iy wHDL Library
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Select

X

Source File

< Back RS Cancel | Help |

fO-1 . s

Mew Source Information

()

Project Mavigator will create a new skeleton source with the
following specifications:

Source Type: Implementation Constraints File
Source Mame: Fa.uck
Agsociation: Fa

Source Directory:  c:hFah
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File Edit View IOBs Areas Tools ‘Window Help
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Xilinx - Project Navigator - c:\FAVFA.ise - [FA.ucf] [ &
File Edit %iew Project Source Process Simulation  Window  Help % - 8 X
= =iz =EIE 74 & -
D|={d|4 =] 2= [ L] se|e] o] sl Q
L | Y S 3 4 3 B
B
N P 1 #PACE: Start of Constraints generated by PACE
Sources in Project: | .
B Faise 3 #PACE: Start of PACE [/0 Pin issignments
- £ c3:400-5pg208 a4 THET "7 Loc = rmporm
n7 H
= [ raran s | uET "B* LoC = mpor
lﬁ—ﬁ[ Athw) 5 | NET "cin” LOC = "pio” ;
= z NET "Cout"™ LOC = "plov?™
=] NET ™3™ LOC = "plog™
=]
10  HPACE: Start of PACE Area Constraints
11
= 12 HPALCE: Ztart of PACE Prohibit Constraints
B Module View ] X Snapshot @ Library Wiew ] 12
14 #PACE: End of Constraints generated by PACE
2l | s
Processes for Source: "'FA ucf” |
[  AddEsisting Source
]  Creats New Source
=@  User Constraints
Cieate Timing Constraints
i3 Azzign Package Ping
553 te Area Constrain
< »
" 4 Frooess View | BB Hiarchy - T8_F tbw | Fav | X Design Sum JBB TB_Fatbw [[2) Fabon RE. ) Fd.uct

Fa-ye g
b oS IS L 90 Generate Programming File ...  Implement Design au ;3 g5, » ,b 98 @il g, p ik 09,5 550 <z -Ve-)
$9y » S5 Lawss SUs Configure device a8 g, » 5L 5o Generate programming file acgema ) 5l e 9 955 Halls K e S5

A ssalive 0,59, wledlbl 51 5,155 usls o Programming File Generation Report
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2 x
Sources in Project: |
B Fhise
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= Fa [Fa.v]
TB_Fa [TB_Fa. thw)
&) Fauct

_ B Module View | I8 Snapshat . @ Library Yiew J

4| x]
Processes for Source: "FA" l;

= iew Design Summary
&F  Design Utiities

&F  User Constraints
Gio? Synthesize - X5T [a
T Implement Design F'
] G Generate Programming
Frogramming File Generation Fep
g Generate PROM, ACE, or JTA
| Configure Device [iMF'AET]| [g
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nx - Project Navigator
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File Edit Wiew Project Source Process Simulation Mindow Help » - 8 x
D|=|u|@| 8| =lw|=| 2= [m L8] ¢|®R0] ]| @) -] 9
L Y o b 3
| x|
Sources in Project ‘ 1 Release 7.1.031 - Bitgen H.41 -
- 2 Copyright (c) 1995-2005 Zilinx, Inc. &4ll rights reserved.
[ Faise 3  Loading device for application Rf Device from file '3s50.nph' in environment
=€ #o3505pg208 4 C:if¥ilinx. -
= FA[FA.v) 5 "Fi" is an NCD, version 3.1, device xc3sS0, package pouz08, speed -5
TB_F& [TB_Fathw] & Opened constraints file FL.pef.
[ Fhouct -
=3 Zat Feh 20 05:32:35 2016
=}
10 C:/X¥ilinx/binfnt/bitgen.exe -intstyle ise -w -g DebugBitstream:No -g Binary:no
11
1= 12 Surmary of Bitgen Options:
B Module View I i Snapshat | [T Library Viaw] 13
14 | Cption Name | Current Setting |
Bk 15
Processes for Source: "FA" I: 18 | Compress | (Hot Specified)® |
+-@gf  Design Utities 17
+ g  UserConshaints 18 | Readback | (Mot Specified)® |
+ K30 Synthesize - 15T 19
# 3e# Implement Design 20 | CGRC | Enshbler® |
=-¥3e# Geneiale Progiamming File 21
B o Frogramming File Generation Repe 22 | DebugBitstream | Mo*# |
Generate PROM, ACE. o JTAG Fi =
g Configure Device (i(MPACT] 24 | ConfigRate | 6%* | a
- o5
Lol | o | [ ) :
B Process View | BB Hierarchy - TB_F thw Fay & Design Sun...| B TB_FAtbw [ FA bon (REA
x|
3 Py
Started process “Programming File Generation Report™.
v

N Conzole I %Find inFiles | J& Ermors [_" ‘Warnings

OY-YV e S

D9l QB (2 8 i 3k oS 9 n (b ol il Glmio Sledas

| want to configure device via :

" Slave Serial Mode
" SelecttAP Mode

" Desktop Configuration Mode

< Back > Cancel Help
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X

Boundary-Scan Mode Selection

+ tomaticaly connect to cable and identify §
Boundary-Scan chain

" Enter a Boundary-Scan Chain

< Back Cancel Help

oYY S

el sadolml Sl e (b 50 a8 ol DIt Wigun b (L aS oS i |y a3l 5 50,8 055 Cua Con aid, Wb al> e ol jo -YY-)

in emw

D d B | A% i Em3 | B N2 apeed|
Boundary-Scan ISIave Selial} SeleclMAF‘} Desktop Configulation]

Assign New Configuration File

Look if: ‘@FA j =F B
| - I __projnas
L&b" 5 ngo

wc3s400 My Recent I _xmsas
~File ? - Documents Byisim

TDO——m— @ [Cisim.kmp_save
Desktop( >

N
My Documents
Validating chain 3!
Boundary-scan ch 3
PROGRESS_END - E| My Computer

Elapsed time =
Device #1 select

TDL

< My Network — File name: [fabit

3 j Open |
Flaces
ot nie=l] Files of type: |4l Design Files | Cancel

‘ Bupass

OF-Y - s
Syl O)le wldas og maliadbae &g 10 S Qb 1) PIPGram o35 5 oS couly SIS asls 0T gy » 0,8 o550 Sz -YT-)
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c:\falFA.ipf [Configuration Mode] - i
Fil= Edit Yiew Mode Operations Output Debug Help

Boundary-Scan |Slave Seriall SeleclMAPl Deskiop Cunfiguraliunl

TDIL

Get Device ID
. Get Device Signature/Usercode
TDO——  IDCODE Looping...

Assign Mew Configuration File. ..

A
Device #1 selected
Device #1 selected ==
bl
& I 3
For Help, press F1 |Configuration Mode  |Boundary-Scan Parallel TI1 Ipt1

8O-\ S

C* c:¥MafFA.ipf [Configuration Mode] - iMP

File Edit ‘iew Mode Operations Output Debug  Help

J (N0 =N W=l Program Options

Boundary-5can | Slave 5 I™ Erase Eefore Programming

I~ Furctional Test

I Verify I~ On-TheFly Program
I™ Read Protect
I~ wiite Protect
TDI Wirtes-l oL
I~ Load FRGA
I Pt PO " Parallel Mode
we3s50 I~ Secure bode I=| Wse D4lfor BF
fabit I™ Program Key
TDO

I™ PROM/CoolRunner| Usercode (8 Hex Digits]
[ FFFFFFFF

I~ %PL& UES: Enter up to 13 characters

A
oo -1 1
Device #1 selected
Device #1 selected QK Cancel | Help |
Device #1 selected =

bt

< | >

For Help, press F1 [Configuration Mode  |Boundary-Scan |Parallel 11T lpk1 l_/‘l
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DEHE * B EAE— E: (=R
Boundary-Scan } Slave Serial I SEIE[:[MAP} Desktop Cunﬁguraliun]

TDI
Operation Status
w3400 Executing command...
fa.bit

Device #1 selected

A
// wxx BATCH CHMD : Program -p 1 0
PROGRESS_START - Starting Operation.

Validating chain...

Boundary-scan chain validated successfully.

*1' :Programming device... 2
hd

< | >

Far Help, press F1 Corfiguration Mode  [Boundary-Scan Parallel ITT Ipt1

OY-1 - S

= c:YafFA.ipf [Configuration Mode] - iMPACT
File Edit Wiew Mode Operations Output Debug  Help

D & & B s 3R 351 E = = | N
Boundary-Scan lSIave Serial] SelectMAF‘] Desktop Configuratiun}

g

wizdz400
fa.bit
TDO.

Programming Succeeded

INFO:iHPACT - 8611 68111 1111 1000 9060 6068 G068 0806

-
INFO:iHMPACT:572 - '1': Completed downloading bit file to device. 0
INFO:iMPACT:580 - "1 :Checking done pin ....done.

*1': Programmed successfully.
PROGRESS_END - End Operation.
Elapsed time = 8 sec. =
bt
< I >
For Help, press F1 Configuration Mode  |[Boundary-Scan Farallel 111 Ipt1
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Gl 422138 oled @

LPM_ADDRESS_CONTROL=

LPM_FILE= : . .
LPM_INDATA="REBISTERED" D[T& RAM32X8S ﬂ?.ﬂ]
LPM_NUMIWORD %= : WE
LPM_OUTOATA"UNREGISTERED' L=
LPR_MAIDTH= & : WCLK
e PMWETHADt TR 4
© LPM RAM IO —
RAM ADDRESS H Jdresal] Al
CHIPSELECT inclock A2
: o]
RO outenab —
................................. X8780
all

ISE (0 MUX (&l sl liéle 5 5o balibl> ciyas Sob V-1 S
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signments  Processing BEEH Window Help
B|o o ik? || EDA Simulation Tool
Run EDA Timing Analysis Tool
T
% BCD_to 7segv a Launch Design Space Explorer
a:a Hardware Setup,

Advangced List Paths
IV Enable realtime 1S {T} TimeQuest Timing Analyzer

Pl Start Advisors

w Stop @ Chip Editor

# Auto Detect Netlist Viewers

5 Delets . (R signalTap II Logic Analyzer

@ ddFie.. [®] Logic Analyzer Interface Editor

hge File SignalProbe Pins..
.,‘l T @ Programmer
8 ki Dovics U d Plug-In Manager...
13 SOPC Builder...
A U Tel Scripts...

Customnize

Options. ..
License Setup...

= In-System Memory Content Editor

-

D_to_7seg.cdf

Ker@@@ Tr o 2 &8 &

l @ Pin Planner

* Mode: JTAG v | Progress:
Il devices)
» |Checksum IUsercode Emgmé l Verify g:::«l:(k
4 00258229 O000FFFF O O
>
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‘MegaWizard Plug-In Manager [page 1]

The Megawizard Plug-ln Manager helps you create or modify
design files that contain custom variations of megafunctions.

Which action do you want to perform?

' Create a new custom megafunction variation
" Edit an existing custom megafunction variation

" Copy an existing custom megafunction variation

Copyright © 1991-2006 Altera Corporation

Cancel I

” Nest > I Finish I
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MegaWizard Plug-In"Manager [page Za]

Which megafunction would you like to customize? Whicg device family will you be ]MAX?IJUDS v!
Select a megafunction from the list below ek
= (8] Installed Plug-ins L,_,J Wwhich type of output file do you want to create?
L] Altera SOPC Builder  AHDL
@ & Aithmetic  VHDL
[+ @& Gates Z
& 10 * Verilog HDL
iy g h;e rT?FE‘ZO mpll?' What name do you want for the output file? Browse...
4 alalie 3 i
£ erial Flash Loader C:A\Documents and Settings\Dear-User\Desktop'J amaloo\compute
|
] SignalTap |l Logic Analyzer
=@ Storage

] ALT3PRAM

A e

[ Retum to this page for another create operation

Note: To compile a project successfully in the Quartus |l software,
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T1:
Tz:

Ts

Ts

: AR < PC
IR ¢« M[AR], PC < PC+1
Do .... D7 ¢« Decode[ IR(12-14)], AR <« IR(0-11) Decode
: AR ¢ M[AR] }

Ty :
. AC ¢ AC+DR, E «Cout, SC<« 0 }

DR ¢ M[AR]
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| Opcode Address
calll
0111 Register Operation
-
1111 Redgister Operation
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Symbol 1=0 I=1 Description
AND Oxxx 8xxx AND memory word to AC
ADD Ixxx 9Xxx ADD memory word to AC
LDA 2XXX AXXX LOAD memory word to AC
STA 3XXX Bxxx Store AC in memory
BUN 4XXX Cxxx Branch unconditionaly
BSA 5XXX Dxxx Branch and save return address
CLA 7800 Clear AC
CLE 7400 Clear E bit
CMA 7200 Complement AC
CME 7100 Complement E bit
CIR 7080 Circulate right AC and E bit
CIL 7040 Circulate Left AC and E bit
INC 7020 Increment AC
SPA 7010 Skip next instruction if AC is
SNA 7008 positive
SZA 7004 Skip next instruction if AC is
SZE 7002 negative
HLT 7001 Skip next instruction if AC is
zero
Skip next instruction if E bit is
zero
Halt Computer
INP F800 Input character to AC
ouT F400 Output character from AC
SKI F200 Skip on input flag
SKO F100 Skip on output flag
ION F080 Intrupt on
IOF F040 Intrupt off
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data terminal ready

signal ground(GND)
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ASR - HyperTerminal
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Save
Save As...

Page Setup...
Print...
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Exit Ale+Fe
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Bits per sec = 2400, Data bits =8, Parity = none, Stop bits =1, Flow control = none
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COM1 Properties E]EI

Port Settings

Connect To | Settings

Change lcon...
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Country /fregion;

Enter the area code without the long-distance prefis. [rata bits:
Area code:
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Restore Defaults
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Set Project to Current File Ctrl+Shift+] 0 ) e 8 ) ek
Save & Check Ctrl+K B adi li alb
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Create Jam or SVF File...

Delete File...

Archive..,
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1 c\max2work'fa

MegaWizard Plug-In Manager

Exit MAX+plus T
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Delete File...
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Save & Simulate Ctrl+Shift+L
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Project

MNew...
Open...
Delete File...
Retrieve..,
Close

Save

Save As..

Info...

Ctrl+0

Ctrl+F4
Ctrl+5

Ctrl+I
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MName...

Set Project to Current File
Save & Check

Save & Compile

Save & Simulate

Save, Compile & Simulate
Archive...
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Ctrl+J
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Ctrl+L
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Elrfa.qdf - Graphic Editor

ﬁa Compiler (o= =]
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Ref Time: [0.0ns | Interval: [0.0ns
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Save & Compile Ctrl+L
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Save As...
Info... Ctrl+1
End Time...

1 chmadworkhfa

Compare...
b il Laa (s b 4 1 2
Import Vector File... 848 silal 9 {:Ji Jﬁﬁdei ila
Create Table File... E.Lﬁjh o el g PLIEER 1P
Create Default Symboal Aalpld LE Azl

Edit Symbol ERCEYLS

Create Default Include File




F @; fa.scf - Waveform Editor

R ,@ Simulator: Timing Simulation

Simulation Input: fa.scf

0.0ns

= b 877 4ns

QUE].IUns

‘1.l]us

‘l].l]ns H MAX+plus I - Simulator Iﬁ
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Connected Pins...
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Info... Ctrl+I
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l@ Quartus I

File i i Project Assignments Proce
Mew... Ctrl+M 1 h2

= Open... Ctrl+ O =
Close Ctrl+F4 .

F New Project wira-—— |

= Open Project... Ctrl+)J
Conwvert MAX+PLUST Project...

Save Project

Close Project

Sawve Ctrl+5
Sawve As...

Save Current Report Section As...
Eile Properties...

Create [ Update
Export...

Conwvert Programming Files...
Page Setup...
Print Preyview

Print...

Recent Files

Recent Projects

Exit Alt+F4
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Window Help
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Project Navigator MES
Entity
Compilation Hierarchy

"Hierarch_l,ll Filesl & Design Unitsl
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What is the working directary for this project?
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What iz the name of this project?
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What is the name of the top-level design entity far this project? This name is case sensitive and must
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Usze Existing Project Settings ...
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Window Help
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Project Navigator e |
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Select the family and device you want to target for compilation.

Show in ‘4vailable device' list

Max7000S amiy | MAKFI00S |
Target device
" Auto device selected by the Fitter
+ Specific device selected in Bvailable devices' list Speed grade: | Any
Core voltage: 5.0V
[¥ Shaw Advanced Devices

Package: By
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I EDA simulation tool
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INew Project Wizard: Sus

‘When you click Finish, the project will be created with the following settings:

Project diectary:
Ci/aleral

Project name:

Toplevel design entiy

Humber of fles added

Humber of user libraries added

Device assignments:
Family name: Max70005
Device: EPM71285L184-10
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Design entry/spnthesis: <None>
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Timing analysis: <Nore>
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n Save Ctrl+5
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Export...
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Paste ! Yalue lype; |9-Level j

Paste Special...
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Repeat Paste...

Delete
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|- Compilation Process Settings Tepizs ety g J
- Analpziz & Synthesis Settings Description:
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File-=New

Sources in Project:

[Mo Project Open)

New Project

— Enter a Mame and Location for the Project

5534 pl e
) Project Mame: Project Location;
F, chWFA

N B Module Viewl 08 Snapshot I TD Librar

Processes for Source: — Select the tupe of Top-Lewvel module for the Project
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HOL |

Schematic
EDIF
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New Project

Select the Device and Design Flow for the Project

Property Hame Yalue

Device Family Spartan3
Device wc3z400
Package pa208
Speed Grade B

|

Top-Level Module Type HOL
Synthesiz T ool #=5T WHDLAY enilog]
Sirmulator ISE Simulakor

Generated Simulation Language |"-"|3ri||:|g

Do Jliew 4350
d b aladl Wl gle 44 3 :_Lh sy o il Al

< Back | M et > | Cancel

New Source
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@ Schematic
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“erilog Test Fisture
By vHDL Library
) WHDL Module
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Define Verilog Source
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input
input
input
output
oLtpLit
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input
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FAJSS

New Source Information
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Port Definitions:
scalar input
scalar input
scalar input
scalar output
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Add Existing Source
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OOCREM 0
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< input EB;
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Processes for Source: "FA" | output 5:
Add Existing Source output Cout:
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View Design Summary
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+--¥3  Generate Post-Synthesis Simulatio
Implement Design

y
A _
+--¥3  Generate Programming File =

1| W[
N B2 Process View

¥




XIlINX 51381 ¢ 55 58 b wal by SLII-Y

Xilinx - Project Mavigator - c:\FA\FA.ise - [FA.v]
File Edit Miew Project Source Process  Simulabion  WWindow  Help

D|=| @ | = 7|5 =BH]0] [m LN (W] || #alH|
W = ATE ( == e ] sl |

1
/ ady 8 GlATH g Cudl S8 4 Module Mame: Fi
New Source // Project MName:
i ew Source

Sources in Project:

Mew Saurce...

Add Source. .. Insert

Add Copy of Source... Shift-+Insert EMM File
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File Mame:

LT
Toagle Paths ch'w avefom Location:

M Properties...
|c:'xFﬂ
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[~ PRLD (CPLD)
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" Single Clock

" Multiple Clacks
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Check Outputs |50 ns After Inputs are Assigned
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|
]
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Compiling verilog f
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Alx
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A Parsing c:\FA/FATest.ant: 6.88
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Iy vHOL Libramy

[] ¥HOL Module

[] ¥HDL Package

4 WHOL Test Bench

[w Add to project

| MHext > | Cancel

B IS




Xilinx - Project Mavigator - c:\FAVFA.ise - [FA.uci
Fil= Edit “iew Projeck Source  Process  Simulation

D|<|@a@ = == D=6
1000 =lns =55

A=
Sources in Project; |

B Fa.isze
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FATest [FATest thw]
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0o @ bWk =

HPACE: Start of PACE Area Constraints

H#PACE: Start of PACE Prohibit Constraints

#PLCE: End of Constraints generated by PACE
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1 0 AT 8 iy G &g 5l 4L ol

134 Jq akia 3y

Assign New Configuration File E'El
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<
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Device #1 selected Flesoiype:  [A1Despn Fies
<
For Help, press F1 Configuration Mod




r

= c:¥falFA.ipf [Configuration Mode] - iMPACT
File Edit View Mode Operations Output Debug Help
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PROGRESS_END - End Operation.

Elapsed time = 9 sec.

4
For Help, press F1

Configuration Mode  |Boundary-Scan Parallzl 11T

[pk1

e

L




QuUArtUS 1331 o 5 5,5 0925 5o 390!

pr S, Ll gl oo 610 oppe B g 05 oo 00ls 58l a5 4y a5 axies LiceNSE (1)ls XilinX sMaxplus ls )58l 5
ol dl> o pai> lyls Quartus sl

2o plsl ) g oo 1251 LS50S i ) 1580 o 55 o
DS S (eeai (Lol o) o wyol o 1, (crack\Windows\\)os 8 asg, ,o WINAOWS g J5ls bgime

C:\altera\quartus60\bin
C:\altera\quartus60\win

2L HOSTID="CHANGEME” & Le sl .05 5L Notepad casle e 38l 05 L1, license.dat L o 5 asg o

Pl ) pgeal 5303 (addiaol )y 5 (Sab S a3l G2l a5 30,358 I s Se a3l HoSEID e o
Iy M 0l 5.2 “Change me” sl & ke ol Crofdla sa S Cada ) - e So (ol (a5l s 4y ) aanS

S dlee ) 158 a5 53 2xy pypeal B 5 S | al )y )38 5 53 S Al

Al \
Run

A culd
C:wUsers Il v»getmac o cmd
Physical Addre Transport Name 19 il S ol Q) Do B3 G
9 getmac

F=39=DF=46=dF=FL 1 = lilia A8 S5 )
8C-73-6E-A8-B1-37 teplip

C:\Usersidilay_ el S gl ead Sal

S cals ol K sl
ipconfiglall /




EDA Simulatinﬂ

Rur EDA Timmng Anabysis Too

E Luwnch Design Space Explarer

& Chip Editar

Methist Yiewers

B signaiTep [ Logic Anabyzer
&= In-Systerm Memory Content Editor
Logic Analyzer Interface Editog

SagnalProbe Pans

W Programmer

\ Megaiizard Plug-In Manager_.
£ SOPC Builder—
Tel Scripts.

Customige...

va e [E:m!fa\hcm.dal

i LM_LICEMSE _FILE wamabls

ert Licenss

‘Wb Licensa Update
brive Type: Full Version

becaiption Expeation: 2020012

b 1D Type: NICID
HID Vahse Ac0MEe1 T

e AMFF M egalons hunchiors:

|t | Prochact

& |CADIS]

a [BAFE)

a |CA04)

1 [BAFT)

2 HALTO (BAES)

a HALTO [BAE2)

8 Device Database [BADS)
4 Device Database [BAD4)
8 ATH [BACS)

5 ATH [BAC)

et Rt
nr

ol Syzbem o

bercrk: Irkeitace Card (NIC) 1D [ecmma?,mme,ammm

Qptions... ! 2

e serial number: [peze1a4

e Guard ID [ Mot found

L= U E
Printing
B Tt Eiton




ALTERA CS s al 3 g (0 O 499 L GJLMT

Logic Lab
NASRSHARGH

Kilinx FPGA
Spartan ||

General /0 Port
General 10 Port

DIF Switch Bank DIF Switch Bank

I Hiline Configuration jumpper |

Atera
Frogramming | Xllinx Programming Port's

‘ Jack Power & Power Swilch

caslus udly 0o
il 0l 28,5 13 5 CPU WS L il b e pdis il ulay] (o) ZARLINK &5 5
(ot i g LED il

LED b= 4 5, S5 LED L= ol W CPLD L FPGA &5 4 jas slaooa,e leie & switch sas aojlas Sed 2 0
cpobed O e a Slasl 2slas gl Seven Segment sue gz ool sul 23 5 M o ool ol olasl gl gl Gy e
.d.-.-:.lLﬁ.-i -"I,.'l-_,.n ':’_J'! iﬁmjm‘}é

bls)l o)) p cge MAX 7000 slaasl oamS e a5 J3 472 J25 el ,oo0lS suled wsonlin o0 p 0 a5 (ol olen

J
4 J25 (o505 & b jlaaall baaal gl wb o5 cud g opas ilacd 5 18 oolinl] 500 Segd 4 Seg3 a3 V ola Sl L
FPGA 4 J3 412 ola,oo50lS &b 5l 3 Segd FA o FY claasl 4 wlool Lata Segd FY 4 F) slaal 4 Seg3 claal 4l5

o |.J""J




eTest Point g ( o>9,5/599,9) /O by ;550

‘_I;LQJLS__.. Q":.a d‘_v_)b ] I M_‘aélé )')5 Sy Jb.b‘ P |) (PIN HEADER) 6"]:-‘. &LB-M_LJP &?‘—i—l'é ébo),x ‘al:-u‘ \_f;‘)__,

CPLD a3 ;o i JESl op )l a0 o) & ulegl alowl 5 am g ailes s 3)ls oy 5l 1) 395 3L 5)0e

12725 425515 CPLD Caad 4o il 00l 43,5 a5 1o jalate 09y J21 323 o256l FPGA Coad ;5 3 124 122 (gla, 2SS

ol pdy 5 ez cpl il 4310 T-SEG gy, 1,724,050 ola b polie moles dad getils asslis b oud a3 5
JESIS L Camnd g o el 0l e3ls )| 3 T10.711.713.714.715.716 TEST POINT suz 5 35 qor a3 Cpimnad

&y 9 J0 o555 CPLD (gl 55 o )8 soliiul 5,00 CPLD L FPGA 23 aabp glp 395 o Jaia LPT1 &gy a4 a5

il 120 25015 FPGA

Golaad e el sal 3.8 U 0 Sd e a IS b b 05 i el Reset Switch S o p e e (2
nL_..u.l Jj.':SJL‘" J.l)b j1 ds 'l":"L-IL_‘-'."' ":‘Jj 'll'f L_l "|"_|'|'2| Ig:u.u._-.ul L..-":' L_';"hjjj .a.LiJLh n}ﬂ.'l-j 5 a 33 & 25 ,_-;Ln:b}l:.lj \-L_h”-_l LI‘;L__! Rﬂgulﬂ.tor

Ggs e yly 3 p =l as S5




Xilinx s pi aislys p o 8390 b GALWT
s XILINX 5 15 ol S o ol 20 Jols Loty cal o5 S ot LS25 _ilises (slo iy 5 FPGA olSitsLajl acgazms
saly 15T T oacms ST ilien (sl i 5 olflegl Lo sy S5l b Las 5 )8 cal o ol abigye Sl
capdis giloe XILINX =8 15 5IFPGA S (bals oy 5l (IS j5b &2 s oo alai |y olSiylol o gl Sl Saly 1 IS 0
iislejl g sy 1y o g cal 35 S5 olfile 5 epmmi 23 ¥ S5 ot laygelS 5 Jlzms o FIlT ol slaceand

Sy paled 0y ol calidee glacians prdgs 4y aslol o il aseia 85l jo aF el len ausled oo sanlie

Anafog Connecors

ﬁ : conng.
Flash

ANALOG .
ANGOS §XILINX
. . PA TAN'—

MAKE IT YOUR ASIC

Jgt»-

Power Managment

.

FPGA o ol,8Ls Ssb ¥ IS5
FPGA bl
4 jsb lar wil oo XILINX 8,5 51 XC38400 6 o 3 ool 00l ol 00 0! (59, oS FPGA jlaa L ol oy
b oS0 ool Sl FPGA (ogadn 5 gy Sl slaalls pacs wlg oo j ol 51 (S plye o XILINK 25,5 w0
o oo Spartan-3 eolgls adl 5 (sym ol 31 (K ol 03503 456 i 4 5 i 1, LFPGA 1 il sla odlgls a8
ol $3) O Ml ol oad ooy olad a9 g LAD/O Sluas abidl> slaces daceS slaws i 51 LT gl ) Jgor 5o

] O \f‘ “Jh‘d )")5 );)L< )L:.:.‘;l )JASC:‘QL: &!):"""S"S‘;""" 4.!L: Y-A \5')|J5PQFP SMWL;Q—J' ) OOL&:—J .))g




Spartan-3 FPGA Family

Spartan-3 ACIL50 LOIS1500
Spartan3l RCIS500L
Spartan-3 EasyFath RLEIS NS00
Spsien Gane X 500K
Ligic Calls b 2 10952
Ricck BAM Bns & 76
Distriberted A2 Ers 1 i
DIWE 4

M oy 1 )

VT SiEn tands i
M= SingleEnded 170+ 14 467

Package and /0 Offerings
WCIRED EOIS1500

Y4 elLmm
Tt 2 x W mm

POIE 38 x 78 mn
FT258 | 7 7 mm
FEIAO x 23 mm

P56 x 23 mm
FEEFER] x2F mm

FESO0AT x31 mm
F&115 35 x 25 mm

e silse g & 3k Sy I XILINX ol F5 0 05ed sl TTAG sy 5l Ol5ioe 2 59) FPGA (6325 aabiy (sl
Ay Sop sy poadies S b sl p ISE 5l e sleali Tl g bate 5 59y 50 JTA jonCS 4 50 Zeas
ol 4 wulai o Ly 351, PROM b 5 FPGA (3, dobiy oSl o5 ool oas 43,8 i s 35 XCFO2S ¢, ;| PROM
oo 15 5 i 4 Sl (o [ J6A g T5A (clayals jslaie

HEan kil er,) wabs Val om:I5A=

A Ean o, b YaY i J6A=

5 ap dausi PROM 3, asli Va ¥ et J0A—=

_‘m|:.-"‘:.:_:.__-_ .h....-:..- PEOM SR ._.. A 4 Y = tJOM =
sanlie 3 Jeam joly o1 Soofs aF ool a3 F 1o a FPGA (o340l Clls s jalaa 4, JOA ol oo

e e

¥ Jeae

Configu ration Moda (1} M M1 Synchronizing Clack
Maslar Sarial 0 ] ] CCLE Qutput
Slave Serial 1 1 G LK Input
Master Paralkel 1 COLE Output
Slave Parallel o 1 CCLH Inpud
JTAG 1 o TCH Input

Hatea:
1. Tha veltage levals an the o, M1, ard W2 pine select tha cenfigumtion moda,
2. The daivy chain i possible only inthe Serial modes when DOUT is used
3 MO=1: 9% Fin 1 emd 2 otinected
I1=1.J9& Fm3 end 9 = vonnscisd
=1 T8 Pin 5 el 63 pomnecied

AR




SREY
YIY o2y O sy VS o 3ol 5l g ol (639, 42035 QS 5 (4,0i5 HESHS) T12 oSO Gyl 510 (6099 425
k_ngeJ.L;.‘L Lv l‘b)ﬁ‘:\';l ‘_QYL] Coannd » &Ja Ia) [ YIY Y& Y ‘_;L%)Ug )LL_-J \_SLAI.ED .Q}i'au.n asl ;Jg Yid 3 \:,Js.

as ody CJ9 WelE Y j' 939,85 e 3L'J9 83gdma g, oo )15’ A \_gLDJ.L'.Js ooy \;.J'o QL‘" 6',3 LED18.19.20.21

Al ol 4 A SO 25 ol S

DAC 2> 35 5299 - P DAC _rys iy
VDD ysis VDD jly ,pits

ADC il 599 r—— S8 Ly jatile

(e JTAG 3,y:il5

ADC
DAC
USB uiir

b
T'segment

DBS jur
IRS232) 10 ~

<y 1Y LED
iy T4 LED
Sy Kl LED iy TYLED
g SLED

olfslagl Lol 3 ¥ IS5

DIP Switch

Button Push

Olee 4wl | oog b o Jeane FPGA TY o Ll 4l 4 a8 ool 428 8 8 0y (g, 20MHz il5 3 L el S5
A8 18 salizl 500 2 Lol clock
aladls

Gl g sals ool sl 5 5,00 )5 5y g5, KERI00SVIC s L% 4 SAMSUNG =5 5 ooy oLS VYA aliils S,

ol adie add salinul cleal cowl ead ea,g] iz cal gliil 2 4 s j0) codl sad Lacs FPGA 4 o] 129




Jlaswe a4 Sl Jus
cul ousl 4285 )8 55 g5, ADTT5 o,lo% 4 Analog Device =5 5 ADC 5 FPGA Loy Fgli] JLS 25l ool
ol 4 ADC 128 el 5 atls Lol ale IS 20MSPS b wilgs o g odd 4 <y B 3lg b 2 e ADC

el oa gadeiia and odlinal ol ol st o3 gl aimis cpl gzl 3 45 Jgaz j0) ceal sal | |z FPGA

Sl @ Jlimws Juss

Analog Device =5 .2 DAC 5, 3l . 9,5 T 4 Folbl JLfn Silay asesi al)) g Folll sl L LL3 ) ol
FPGA (slo by 4 )] 208 clgllfs 3 anls b g ¥ o IS s B 5 Y/ i b 2 cia DAC fpl oo i anlicd
ol s s ol solizol gloasl ol and oo gl imin [l clgmil o 45 Jaas o) coil oad | Juata

(=8> 525,5) U0 Lo 55018

wlizt b BLI) el o 5 s o g clanl and 8 ks 0l Yo g — (00,5758 S5 0 g5 b BLS ) 6l
el J14 oS8 -l dgal aalinal 500 oo glea g b g LCD asile il

USB e85l

el 5 iy 8y ez s e 3 45 Cel ah 48 F L5 3 ONI oSS 5alS USB 200 b bl ) (o

RS-232 ¢ s bLJ |
Sisp ) 45 jewsll COM cip L bls) ol cébs ks g Jlo) ks glgs 4 FPGA

RS-232 cclojlly 4 MAXIM =5 5 MAX233 il @b 5l al oo ool codd adl 428l 0 4S a solic.l RS-232

Ry A 15 N T
""""\J‘n_c‘“ |_,L"°"j W DBQ _:_’._,LISA.?;.:..L..- ‘_H.-\.'L:.I

alael gulai (gly | Zawd cde Slisled sue Jlps i g e gl gulai ol wisl sad guniazin 7850 F W LED A
oot Codp gle Bialas ol jamper S cpcmwes aiTuw | JeTa FPGA cloasls 3l g0 S0 @ a¥ cal dgmaa a0 0n, .o g

P g - (UVEL SR L g EE S PR S PR S [P TR B - I PRI - R 4 | ES I T PR R 6. SR

F &

RESET 5 533,35 & gos
2ay8 slellfos slp ol Lo DIP Switch sue 4w g ... g Reset sl ol aliod | cog,5 slgfLEos ¢l Push Button

AT sy ‘_!...ﬂ-_l! FPGA _gl_t. J.._l_lJ___ _3.| & ,j_, 4 45 sl d:j_.,f Jku oLy, --- 3 _QJ_:l__n BCD slac! le_._l_-,' ,L_.‘;l_.,J_ |__|_ :semug




1

U2A

e}
11O
e}
I/O VREF
e}

/O VREF
e}

e}
11O
e}
e}
/O VREF
11O
]
110
e}
e}

I/O VREF

VCO

VCO

===
VCO [CRGRO)

lle]
le]
lle]
lle]
lje]

e} IO VREF

lle]
l/e]

11O IFO,VREF

lle]
lle]
o]
lle]

M2
M1
MO

e} DONE
[} PRGRAM*

e} VCCINT
VCCINT
VCO VCCINT

34 xled1

Xled2
J.ﬁ_xmr
R E—

43 C2o0

44 F160*
FOo*

48 xsegli
49 xsegil2

54 M2

50 M

52 MO

104 DONE
6

25

NEEE

XC28150-5PQ208 _ |

XIO19

uac

XIO18

XIOT7

XIO16

XIO15

XIO14

XIO13

X012

X101

i 174

144

130

156

110
lle]
le}
11O
11O VREF
l{e]
l[e]
1/O, VREF
11O
11O
11O
le]
l{e]
11O

1/O VREF

11O
11O
11O

TMS
TCK
TDI

TDO

VCO
VCO
VCO
VCO

l{e]
l{e]
[l{e]
l{e]
/O VREF
lje]
l{e]
l{e]
l{e]
l{e]
l{e]
/O VREF
lje]
l{e]
/O VREF
l{e]

XC28150-5PQ208

XC28150-5PQ208

o]
o]
l[e]
/O, VREF
/O,VREF (o]
le] o]
l{e] 11O
l{e] Vo]
l{e] o]
l{e] e}
l{e] IfO,VREF
I/O,VREF /o]
l{e] 110
l{e] I/O,VREF
/o]
GCKO
GCK1

xseg32

xseg33
XSeg34
XSeg3b
XSEg36
87 XSeg37
xseg38
xsegd 1
XSegazZ
Xseg43
95 xsegdd

xseg45
97 x5eg46
98 xseg47
xseg48
100 Xing
101 xin10
102 xin11

25

]

u2D

XILINX FPGA

e}
le]

e}
/O VREF
e}
170
/O VREF
11O

e}
[}

l{e}
/O VREF
11O
e}
e}

VCO

VCO

VCO

XC28150-5PQ208

VCO

e} /O VREF

e} I/O VREF

e} I/O VREF
l{e]

l{e]
o]

l{e]
l{e]
l{e]
l{e]
l{e]
l{e]

l{e]
le]

l{e]
l{e]




(ol o} NN o} S H TN A N}

Switches & LEDs

Xled2 |

(o o NB o} S § TN S ) N

VCC

aled9

aled10

aledT

LED15
LED

y

aled12

LED16
LED




[

i

PUSHBUTTON

D1
1N4148

U9

0OSCo
OSCi
F160*
FOo*
F8o
C1.50
C30*
C2o
C40*

C8o*
C160*

VDD

VDD

VSS
VSS

RS-232 & mt9042

VCC
R34

ANRE

MT9042C

aseg31

aseg32

asegad

asega4

aseg35s

asegab

asega’

aseg3d

aseg41

aseg42

u7

C
1

14
uf
Cc15

1uf

C1+ VCC

033

CONZ20A

V+ GND

SIO0TX

C1- T10UT

SIO0ORX

C2+ R1IN

RXO0

VCC

FOo* 2
aaa
aaal 4
aaa 5
aaa 6
aaa 7
aaa
aaa’
aaad

C2- R10OUT

TX0

V- T1IN
T20UT T2IN
R2IN R20UT

max3232

o

—o
'o)
o
o

o)




|

7Segment & 10

xseg28 xseg11
xseg27 xseg 12
pows pows
Xseg26 xseg13
xseg25 xsegi14

Seven Segment

| 45
seg8 46 asegl7
xseg48 xseg31 i aseg18

xsegd7 Xsego2l aseg21
pows pows [ pows aseg2?
xseg46 Xseg33 aseg23
xseg45 xseg34 aseg24

52 aseg25

Seven Segment Seven Segment i aseg26
aseg27
aseg28
asegis
57 asegi14

aseg15
59 aseg16

E2CLK

DONE21

R10
ANAN

1K
AR 033

INIT19

C3 R8
use 4.7u R
VCC
VCC 33

VCC

VCCO
VCCO
VCCO
VCCO

DONE21
—rmTTQ—ZL CE*
—p-1—5—19— OE/RESET*
. ——

cF*
—27 | deon

oo
ZzZ
QO

XC18V04PC44 §




(Spartan3) FPGA sleal sou,So

FPGA Pin
Number

Application I

FPGA Pin
Number

Application

FPGA Pin
Number

Application

7SEG3-d
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ADC-DO

TXO0

71
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77

105

144

usbD4
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R1A13

DAC_D4

189

7SEG4-c

R10E

DAC_D5

190

usbD1
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